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Chapter 1. MicroEJ Overview

1.1. MicroEJ Editions
MicroEJ offers a comprehensive toolset to build the embedded sofware of a device. The toolset covers
two levels in device software development:

• MicroEJ SDK for device firmware development

• MicroEJ Studio for application development

The firmware will generally be produced by the device OEM, it includes all device drivers and a specific
set of MicroEJ OS functionalities useful for application developers targeting this device.

Figure 1.1. MicroEJ OS Development Tools Overview

Using the MicroEJ SDK tool, a firmware developer will produce two versions of the MicroEJ OS binary,
each one able to run applications created with the MicroEJ Studio tool:

• A firmware binary to be flashed on OEM devices

• A Virtual Device which will be used as a device simulator by application developers

Using the MicroEJ Studio tool, an application developer will be able to:

• Import Virtual Devices matching his target hardware in order to develop and test applications
on the simulator.

• Deploy the application locally on an hardware device equipped with the MicroEJ OS firmware
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• Package and publish the application on a store, enabling remote end users to install it on their
devices.

1.2. Firmware

1.2.1. Bootable Binary with Core Services

A MicroEJ firmware is a binary software program that can be programmed into the flash memory of a
device. A MicroEJ firmware includes an instance of a MicroEJ OS linked to:

• underlying native libraries and BSP + RTOS,

• MicroEJ libraries and application code (C and Java code).

Figure 1.2. MicroEJ Firmware Architecture

1.2.2. Specification

The set of libraries included in the firmware and its dimensioning limitations (maximum number
of simultaneous threads, open connections, …) are firmware specific. Please refer to http://
developer.microej.com/getting-started.html firmware release notes.
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1.3. Virtual Device

1.3.1. Using a Virtual Device for Simulation

The virtual device includes the same custom MicroEJ OS Core, libraries and resident applications as
the real device. The virtual device allows developers to run their applications either on the Simulator,
or directly on the real device through local deployment.

The Simulator runs a mockup board support package (BSP Mock) that mimics the hardware function-
ality. An application on the simulator is run as a standalone application

Before an application is locally deployed on device, MicroEJ Studio ensures that it does not depend on
any API that is unavailable on the device.

Figure 1.3. MicroEJ Virtual Device Architecture

1.3.2. Exposed APIs

The set of MicroEJ OS APIs exposed by a virtual device (and therefore provided by its associated firw-
mare) is documented in Javadoc® format in the MicroEJ Resource Center (Window > Show View
> MicroEJ Resource Center).
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Figure 1.4. MicroEJ Resource Center APIs
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Chapter 2. MicroEJ Studio Getting Started

2.1. Introducing MicroEJ Studio
MicroEJ Studio provides tools based on Eclipse to develop software applications for MicroEJ-ready de-
vices. MicroEJ Studio allows application developers to write MicroEJ applications, run them on a virtual
(simulated) or real device, and publish them to the MicroEJ Application Store.

This document is a step-by-step introduction to application development with MicroEJ Studio. The
purpose of MicroEJ Studio is to develop for targeted MCU/MPU computers (IoT, wearable, etc.) and it
is therefore a cross-development tool.

Unlike standard low-level cross-development tools, MicroEJ Studio offers unique services like hard-
ware simulation, local deployment to the target hardware and final publication to a MicroEJ Applica-
tion Store.

Application development is based on the following elements:

• MicroEJ Studio, the integrated development environment for writing applications. It is based on
Eclipse and is relies on the integrated Java compiler (JDT). It also provides a dependency man-
ager for managing MicroEJ Libraries (see Section 8.5, “Library Dependency Manager”). The cur-
rent version of MicroEJ Studio is built on top of Eclipse Mars (http://www.eclipse.org/
downloads/packages/release/Mars/2).

• MicroEJ Virtual Device, a software package including the resources and tools required for build-
ing and testing an application for a specific MicroEJ-ready device. Virtual Devices are import-
ed into MicroEJ Studio within a local folder called MicroEJ Platforms repository. Once a Virtual
Device is imported, an application can be launched and tested on simulator. It also provides a
means to locally deploy the application on a MicroEJ-ready device.

• MicroEJ-ready device, an hardware device that has been previously programmed with a MicroEJ
firmware. A MicroEJ firmware is a binary instance of MicroEJ OS for a target hardware board. Mi-
croEJ-ready devices are built using MicroEJ SDK. MicroEJ Virtual Devices and MicroEJ Firmwares
share the same version (there is a 1:1 mapping).

The following figure gives an overview of MicroEJ Studio possibilities:
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Figure 2.1. MicroEJ Application Development Overview

Starting from scratch, the steps to go through the whole process are detailed in the following sections
of this chapter :

• Download and install MicroEJ Studio

• Download and install a Virtual Device

• Download, build and run your first application on simulator

• Download and install MicroEJ firmware on target hardware

• Build and run your first application on target hardware

• Package and publish your application to the store

Several steps include software download and installation, the following figure gives an overview of the
MicroEJ software components required for both host computer and target hardware:
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Figure 2.2. MicroEJ Studio Development Imported Elements

2.2. Install and Setup MicroEJ Studio

2.2.1. Download and Install MicroEJ Studio

A Java™ Runtime Environment is needed on your host computer for running MicroEJ Studio. Download
Java™ from http://java.com/en.

MicroEJ Studio is available for download on http://developer.microej.com/get-
ting-started.html. It can run on the following host operating systems:

• Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Vista or Windows XP SP3

• Linux distributions (tested on Ubuntu 12.04 and Ubuntu 14.04)

• Mac OS X (tested on version 10.10 Yosemite and 10.11 El Capitan)

After downloading the suitable version of MicroEJ Studio, extract the content of the ZIP file and launch
the installation process:
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Start MicroEJ Studio. It prompts you to select the last used workspace or a default workspace on the
first run. A workspace is a main folder where to find a set of projects containing source code. When load-
ing a new workspace, MicroEJ Studio prompts for the location of the MicroEJ Platforms repository. By
default, MicroEJ Studio suggests to point to the default MicroEJ Platforms repository on your operating
system, located at ${user.home}/.microej/repositories/[version]). You can select an
alternative location. Another common practice is to define a local repository relative to the workspace,
so that the workspace is self-contained, without external file system links and can be shared within a
zip file.

2.2.2. Download and Install a Virtual Device
MicroEJ Studio being a cross development tool, it does not build software targeted to your host desk-
top platform. In order to run MicroEJ applications, a target hardware is required. Several commercial
targets boards from main MCU/MPU chip manufacturers can be prepared to run MicroEJ applications,
you can also run your applications without one of these boards with the help of a Virtual Device.

A MicroEJ Virtual Device is a software package including the resources and tools required for building
and testing an application for a specific MicroEJ-ready device.

A Virtual Device will simulate all capabilities of the corresponding hardware board:

• Computation and Memory

• Communication channels (e.g. Network, USB ...)

• Display

• User interaction

Virtual Devices are available at http://developer.microej.com/getting-started.html.
In this document all examples will be provided with the following target boards:

• STMicroelectronics STM32F746G-DISCO board

After downloading the Virtual Device installer (STM32F746GDISCO-Wadapps-
VirtualDevice-1.5.1.jpf file), launch MicroEJ Studio on your desktop to start the process of
Platform installation:
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• Open the Platform view in MicroEJ Studio, select Window > Preferences > MicroEJ >
Platforms. The view should be empty on a fresh install of the tool

• press Import... button.

• Choose Select File... and use the Browse option to navigate to the .jpf file containing
your Virtual Device, then read and accept the license agreement to proceed.
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• The Virtual Device should now appear in the Platforms view, with a green valid mark.

2.3. Build and Run an Application

2.3.1. Import a MicroEJ Sample Application

Download the Hello sample application from http://developer.microej.com/get-

ting-started.html.

The first step is to import the sample application in your workspace. Select File > Import... >
General > Existing projects into workspace.
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In the Import window, select Archive File and navigate with Browse to the zip file you down-
loaded.
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The file contains one project named ej.wadapps.app.demo.hello, select it and click on Fin-
ish. You now have an application project imported in MicroEJ Studio. You can navigate the folder tree
and open java sources.



MicroEJ Studio Getting Started

13

2.3.2. Run on the Simulator

Launch the application on Simulator:

To run the sample project on Simulator, select it in the left panel then right-click and select Run >
Run as > MicroEJ Application.

Launch steps will display messages in MicroEJ Studio Console and the Simulator will display on the
screen
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Clicking on the "Home" button will display messages in the Console.

2.3.3. Prepare an Hardware Board

Download and install the target programming tool. For example for STM32 microcontrollers family,
the programming tool is named STM32 ST-LINK utility, is available on Windows® platforms and can be
downloaded from http://www.st.com/web/en/catalog/tools/PF258168.

Use the target tool to program the firmware on the hardware board (example for STM32F7). The first
step is to install an empty Micro-SD card in your board.
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Connect your board to the host PC with a USB cable, the STM32F746G-DISCO board has three USB con-
nectors, from left to right:

• CN14 - USB ST-LINK (Mini-B connector)

• CN13 - USB_FS (Micro-B connector)

• CN12 - USB_HS (Micro-B connector)

For power supply, you can select the ST-LINK connector by setting jumper JP1 on the back of the board,
next to the reset button. You must select "CN14 USB ST-LINK" (factory settings) when you use the STM32
ST-LINK utility, you need a cable with a "Mini-B" connector.

Once the board is connected, the screen displays the factory installed application, in ST-LINK Utility
select the connect button in the toolbar and the tool will display the characteristics of the processor.
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You must add an external loader to ST-LINK Utility by selecting "Add External Loader" and select the
loader that correspond to the STM32F746G-DISCO board

Once the loader is added, the MicroEJ firmware may be sent to the board by selecting Target >
Program and navigating to the HEX file.
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The final flashing step requires validation, it will take a while to transfer and control the binary file sent
to the board.

After ST-LINK Utility disconnect, the board will display the application desktop.
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2.3.4. Deploy Locally on Hardware

Local deployment of the application on the target will follow several steps, first on the board and then
from MicroEJ Studio:

• Connect the board to your PC through USB for power

• Connect the RJ45 of the board to a network with a DHCP server

• Read the board's IP address using the "Settings" application

• Prepare the Run configuration in MicroEJ studio

• Deploy and test the application on the board
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When the board is powered and connected to a DHCP network, it will obtain an IP address visible in
the Settings application:

In MicroEJ open the Run > Run Configurations... window and select [Local Deploy-
ment] Hello STM32F746G-DISCO in the left panel. The execution option is set to Execute on
device.
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Open the Configuration tab and type the IP address of the board, then press Run. The MicroEJ
Console will display build and deployment messages.

The application is now visible on the target's screen.

2.4. Application Publication

2.4.1. Build the WPK
When the application is ready for deployment, the last step in MicroEJ Studio is to create the WPK
(Wadapps PacKage) file that is intended to be published on a MicroEJ Store for end users.

In MicroEJ Studio, right click on project name and choose: Build Selected Sandboxed Ap-
plications.
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The WPK build process will display messages in MicroEJ console, ending up with a BUILD SUCCESS-
FUL message.

2.4.2. Publish on a MicroEJ Store

The WPK file produced by the build process is located in a dedicated target~/artifacts folder
in the project.
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The .wpk file is ready to be uploaded to a MicroEJ Store. Please consult https://
community.microej.com for more information.

2.5. Application Development
The following sections of this document shall prove useful as a reference when developing applications
for MicroEJ. They cover concepts essential to MicroEJ applications design.

In addition to these sections, by going to http://developer.microej.com/, you can access a
number of helpful resources such as:

• Libraries,

• Application Examples, with their source code,

• Documentation (HOWTOs, Reference Manuals, APIs javadoc...)
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Chapter 3. Wadapps Framework

3.1. MicroEJ Component Framework
MicroEJ OS offers a multi-application execution framework called Wadapps framework. The basic fea-
tures offered by the Wadapps framework for each application include:

• Dynamic installation and uninstallation

• Execution lifecycle management (Activities and Background Services)

• Services usage

• Inter-application communication (Chapter 7, Shared Interfaces)

Figure 3.1. Wadapps Framework Components View

3.2. Execution Lifecycle
Depending on the application nature, two execution modes are available in the Wadapps framework:

• Background Service

• Activity

Background Service is suitable for applications with no graphic interface, whereas Activity is dedicat-
ed to applications using the screen and user interface. An application must declare at least one back-
ground service or activity, and can declare a mix of both.



Wadapps Framework

24

3.2.1. Background Service Lifecycle
A background service entry point is a class that extends the
ej.wadapps.app.BackgroundService interface which offers a small set of methods dedicated
to the lifecycle of an application with no graphic interface:

• public void onStart()

• public void onStop()

Usually, a background service has a unique active state. The onStart() method is called just after
the application has been started and gives the entry point to start its job. This can be just starting a
thread or simply registering a shared service (see Section 7.4, “System Registries”). The onStop()
method is called just before the application is stopped and gives to the application the opportunity to
properly save its state. Note that background service lifecycle methods are assumed to return quickly.
In case of long blocking code, a new thread must be created.

Figure 3.2. Background Service Lifecycle within an application

3.2.2. Activity Lifecycle
An activity entry point is a class that extends the ej.wadapps.app.Activity interface which of-
fers a more comprehensive set of methods dedicated to the lifecycle of an application with a graphic
interface:

• public void onCreate()

• public void onDestroy()

• public void onStart()
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• public void onRestart()

• public void onStop()

• public void onPause()

• public void onResume()

Note that as for a background service, activity lifecycle methods are assumed to return quickly. In case
of long blocking code, a new thread must be created.

An activity must share the Graphical User Interface with other activities, either from the same applica-
tion or from different ones. As a consequence the implementation of the Activity interface must handle
transitions between several activity states:

• CREATED

• STARTED

• PAUSED

Figure 3.3. Activity Lifecycle Within an Application
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3.3. Services Usage
The Wadapps framework provides a service oriented mechanism where generic services may be pro-
vided on several levels:

• Application local implementation

• MicroEJ OS provided service

• Service shared by another application

Services retrieval order follows the order of the previous list. An application local implementation may
override a MicroEJ OS provided service. A MicroEJ OS provided service cannot be overridden by a ser-
vice shared by an other application.

Figure 3.4. Wadapps Services Providers

3.3.1. Retrieving Services
Services are retrieved in a transparent way however they have been published, us-
ing the default service loader. Given a class that represents the service API, it re-
turns the registered implementation. The default service loader can be retrieved using
ej.components.dependencyinjection.ServiceLoaderFactory.getServiceLoader().

Then, the service implementation is retrieved using
ej.components.dependencyinjection.ServiceLoader.getService(Class).



Wadapps Framework

27

Next figure is an example for retrieving the ej.wadapps.storage.Storage service.

Figure 3.5. Wadapps Service Retrieval Example

3.3.2. Application Local Services

Application local services are provided as an application's local class and declared in the META-INF/
services section of the project (see Section 4.3.4, “Services Folder”).

3.3.3. Shared Registry

External services may be provided by an application to another application through the Shared Registry
mechanism (see Section 7.4, “System Registries”).

3.4. Standalone vs Sandboxed Application
A standalone application is an application that defines a main entry point (a class that contains a pub-
lic static void main(String[]) method). A standalone application can be run on the sim-
ulator and is intended to be statically linked with a platform to produce a firmware.

A sandboxed application is an application that is defined in MicroEJ Studio with the sandboxed appli-
cation structure (see Chapter 4, Sandboxed Application Structure). A sandboxed application is intended
to be dynamically deployed on a firmware. MicroEJ Studio provides a bridge for using a sandboxed
application as a standalone application by autogenerating standalone main entry points and allowing
to fetch standalone specific dependencies.

3.4.1. Automatically Generated Standalone Entry Points

For a sandboxed application, MicroEJ Studio automatically generates standalone main entry point.
The main entry point is in charge to start the wadapps framework that will activate declared Ac-
tivities and BackgroundServices. One specific main entry point is generated per declared Activi-
ty. Standalone classes names have the Standalone suffix. The autogenerated code is located in
src/.generated~/java source folder of a sandboxed application project.



Wadapps Framework

28

Figure 3.6. Sandboxed Application Autogenerated Structure

The src/.generated folder is hidden by default. To make it visible, in Packages Explorer select
the Filters... menu and check .* resources item.

Figure 3.7. Package Explorer Filters... Menu

3.4.2. Standalone Application Specific Dependencies
MicroEJ allows to declare additional dependencies that will be taken into account only when launch-
ing a standalone application such as the Simulator. This is done by defining a built-in Ivy configura-
tion named microej.launch.standalone in the module.ivy file of a sandboxed application
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project. Refer to the module.ivy generated by the application template (Section 4.1, “Application
Template Creation”) to get the list of required standalone libraries.

<dependencies>

     […]

 <!-- 

  A Classpath dependency only used by 

  standalone application launches 

 -->

 <dependency 

  org="com.mycompany" name="xxx" rev="xxx" 

  conf="microej.launch.standalone->*"

 />

</dependencies>
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Chapter 4. Sandboxed Application
Structure

4.1. Application Template Creation
The first step to explore a sandboxed application structure is to create a new projet for the development
of a graphical application. First select File > New > MicroEJ Sandboxed Application
Project:

Fill in the application template fields, the Project name field will automatically duplicate in the
following fields.
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A template project is automatically created and ready to use, this project already contains all places
where the application developer will put content:

• src/main/java: Folder for future sources

• src/main/resources: Folder for future resources (images, fonts etc.)

• META-INF: Sandboxed application configuration and resources

• module.ivy: Ivy input file, dependencies description for the current project

The Ivy section contains the list of dependencies automatically resolved by Ivy from the content of
module.ivy, from a development perspective this section is read-only.

The application functionalities will determine which parts of this structure are impacted, for example
the development of a simple "Hello world" application will only impact the src/main/java fold-
er and META-INF/MANIFEST.MF file.

4.2. Sources Folder
The project source folder (src) contains two areas:

• Source
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• Resources

Source folder will contain all .java files of the project, resources folder will contain elements that the
application will use at runtime like raw resources, images or character fonts.

4.3. META-INF Folder
The META-INF folder contains several folders and one file named the manifest file described hereafter.

4.3.1. Certificate Folder
Contains certificate information used during the application deployment.

4.3.2. Libraries Folder
Contains a list of additional libraries useful to the application and not resolved through the regular
transitive dependency check

4.3.3. Properties Folder
Contains an application.properties file which contains application specific properties that can
be accessed at runtime.

4.3.4. Services Folder
Contains a list of files that describe local services provided by the application (see Section 3.3.2, “Ap-
plication Local Services”). Each file name represents a service class fully qualified name, and each file
contains the fully qualified name of the provided service implementation.

4.3.5. Manifest File
The file META-INF/MANIFEST.MF is initialized with the information given on project creation, extra
information may be added to this file to declare the entry points of the application.

4.4. module.ivy File
The module.ivy file contains a description of all the libraries required by the appliction at runtime
(see Section 8.5, “Library Dependency Manager”).
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Chapter 5. Background Service Application

5.1. Create a Sandboxed Application Project
In MicroEJ menu, select: File > New > MicroEJ Sandboxed Application Project an give
MySandboxedApp as the project name, a template project is automatically created and ready to use.

For the detailed content of the project structure, please consult section Chapter 4, Sandboxed Applica-
tion Structure. Here is a list of the elements we will modify for the simple sandboxed application:

• src/main/java: Add source files

• META-INF/MANIFEST.MF: Set application's BackgroundService entry point

5.2. Fill the Application Structure

5.2.1. Simple Background Application Code
The classic Hello World application, which does not use the Graphical User Interface, is a good example
of a BackgroundService entry point.

5.2.1.1. Classes

Create a new class in the src/main/java folder of the empty project:
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Fill the new class with package information and give it a name that tells about its role as a Background
Service. Notice that we have added the ej.wadapps.app.BackgroundService interface from
the wadapps framework and that the class does not have a main() method.

The code to output messages on the console can now be added to the onStart() method, we also
add a message to the onStop() method in order to follow the application's life cycle.
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5.2.2. Manifest File Configuration

Our simple background application has one BackgroundService entrypoint. The
appEntry.MyBackgroundCode class fully qualified name must be registered in the Applica-
tion-BackgroundServices entry in the MANIFEST.MF file.
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5.3. Test on a Virtual Device
To launch the application on the Simulator, select the MySandboxedApp project and in the MicroEJ
top menu select Run > Run As > MicroEJ Application.

As this is the first launch for the application, the target must be set up for the launcher. If there is only
one platform available in the MicroEJ repository, this platform is automatically selected. Otherwise, a
popup window invites to select the platform on which the application must be launched. Select the
virtual device:

The application executes on the Simulator, as no graphic code is present the Simulator will not display
its user interface and directly send output to the MicroEJ Studio Console window.
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To edit the MicroEJ Launch Configuration automatically created by this first launch, open Run > Run
Configurations... window. On the left panel open the MicroEJ Application category and
select the BackgroundserviceStandalone run configuration.

The name of the run configuration was generated automatically from the name of the startup Class, you
may change it to a more descriptive string (i.e. MySandBoxedApp [SIMU]). Note that the type selected
for launching on simulator is the autogenerated main type for standalone application (see Section 3.4,
“Standalone vs Sandboxed Application”).

In the Execution tab of the run configuration, the Platform is set to the selected Virtual Device and
execution mode set to Execute on Simulator.
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5.4. Test on Target Hardware

5.4.1. Create a Run Configuration for the Target Hardware

The run configuration for the target hardware is duplicated from the existing MySandboxedApp
[SIMU] for the Simulator. In the left panel of Run Configurations window, right click on
MySandboxedApp [SIMU] item and select Duplicate.

Rename the duplicated launcher to MySandboxedApp [LOCAL], modify the execution mode to
Execute on Device and check that Settings is set to Local Deployment.

Next steps will be on the target hardware.

Your Target and Host PC must be connected through:

• USB link for Power and debug on serial port (Termite, Putty ...)

• Ethernet link with a DHCP server to obtain an IP address
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Open the Settings resident application on the target and scroll down to read the IP address.
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Enter the IP address on the Host field in the Configuration tab of the MySandboxedApp [LO-
CAL] launcher.

The run configuration is now ready for local deployment on the target.

5.4.2. Local Deployment on the Target Hardware

Run the MySandboxedApp [LOCAL] launcher, deployment steps are shown on the MicroEJ console.
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The application is now visible on the screen of the target:

And debug traces show the life cycle of the sandboxed application.
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Chapter 6. Activity Application

6.1. Develop an Activity Application

6.1.1. Create a Sandboxed Application Project

The first step to explore a sandboxed application structure is to create a new projet for the development
of a graphical application.

See Section 5.1, “Create a Sandboxed Application Project” for creating a ready to use template project.

6.1.2. Create an Activity Implementation

A graphical application will have an Activity entry point to allow for screen sharing with other
graphical applications. The first step is to create a class that will be the entry point of our sand-
boxed application. This class is located in the src/main/java folder and shall implement the
ej.wadapps.app.Activity interface.
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6.1.3. Update the Manifest File

Methods of the Activity interface handle the whole life cycle of a graphical application. The
app.dev.MyActivity class fully qualified name must be registered in the Application-Ac-
tivities entry in the MANIFEST.MF file.
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The onStart() method will do the job of initializing graphical objects.

6.1.4. Add Graphical Library Dependency

Since the application uses graphical objects, we have to complete module.ivy file to add a depen-
dency to the corresponding GUI library: MicroUI (basic drawing elements).

The line describing this library is inserted in the dependency section of the module.ivy file. See
Section 8.5, “Library Dependency Manager” for more information about classpath dependencies man-
agement.

6.1.5. Implement a Graphical Class

A new class is added to the project for implementation of the graphical behavior, this class is named
app.dev.Program and extends the ej.microui.display.Displayable MicroUI class.
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An instance of app.dev.Program is created in the Activity onStart() method, for this a dedicated
constructor is added to the Program Class, with a reference to an image resource.



Activity Application

47

The paint method of the ej.microui.display.Displayable object is responsible for graphical
output, the code of this method will first clear the screen by drawing a white rectangle, then compute
layout infomation before displaying an image and a text.

In order to react to user events, an EventHandler implementation is added to the app.dev.Program
class. The implementation of handleEvent() method will test the pointer events in order to detect
user actions.
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6.2. Add Application Resources

6.2.1. Add Images Resources

As shown in the previous section, the app.dev.Program class uses an image from a PNG file from
image "microej.png" file which can be duplicated from the Hello sample. This file is embedded in the
application by adding the microej.png file to a src/main/resources/images folder, and by
adding a reference to this file in the app.gui.images.list file added to the src/main/re-
sources/app/dev folder (see Section 8.3.6, “Images” for images list files specification).

6.2.2. Add Fonts Resources

A dedicated large font will be used to display the text on the Button widget, the font will be embded-
ded in the application by using the same technique as the image file. The droid_sans_44px.ejf
font file is copied from Hello sample to a "src/main/resources/fonts folder, and a new
app.gui.fonts.list file containing the font reference is created in the src/main/re-
sources/app/dev folder" (see Section 8.3.7, “Fonts” for fonts list files specification).
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6.3. Test the Application on Simulator

6.3.1. Create a Run Configuration

To rapidly test the application, right click on project's name and select Run as > MicroEJ Ap-
plication.

The simulator will launch with the following graphical result:
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Clicking on the screen will produce the following result in the MicroEJ Studio Console:
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Chapter 7. Shared Interfaces

7.1. Principle
The Shared Interface mechanism provided by MicroEJ OS is an object communication bus based on
plain Java interfaces where method calls are allowed to cross MicroEJ Sandboxed applications bound-
aries. The Shared Interface mechanism is the cornerstone for designing reliable Service Oriented Ar-
chitectures on top of MicroEJ OS. Communication is based on the sharing of interfaces defining APIs
(Contract Oriented Programming).

The basic schema:

• A provider application publishes an implementation for a shared interface into a system registry
(see Section 7.4, “System Registries”).

• A user application retrieves the implementation from the system registry and directly calls the
methods defined by the shared interface

Figure 7.1. Shared Interface Call Mechanism

7.2. Shared Interface Creation
Creation of a shared interface follows three steps:

• Interface definition

• Proxy implementation

• Interface registration

7.2.1. Interface Definition

The definition of a shared interface starts by defining a standard Java interface.
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package mypackage;

public interface MyInterface{ 

 void foo();

}

To declare an interface as a shared interface, it must be registered in a shared interfaces identification
file. A shared interface identification file is an XML file with the .si suffix with the following format:

<sharedInterfaces>

 <sharedInterface name="mypackage.MyInterface"/>

</sharedInterfaces>

Shared interface identification files must be placed at the root of a path of the application classpath.
For a MicroEJ Sandboxed application project, it is typically placed in src/main/resources folder.

Some restrictions apply to shared interface compared to standard java interfaces:

• Types for parameters and return values must be transferable types

• Thrown exceptions must be exceptions owned by the MicroEJ OS

7.2.2. Transferable Types
In the process of a cross-application method call, parameters and return value of methods declared in
a shared interface must be transferred back and forth between application boundaries.

Figure 7.2. Shared Interface Parameters Transfer

Table 7.1, “Shared Interface Types Transfer Rules” describes the rules applied depending on the ele-
ment to be transferred.

Table 7.1. Shared Interface Types Transfer Rules

Type Owner Instance
Owner

Rule

Base type N/A N/A Passing by value. (boolean, byte,
short, char, int, long, double,
float)
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Type Owner Instance
Owner

Rule

Any Class, Array or Inter-
face

MicroEJ OS MicroEJ OS Passing by reference

Any Class, Array or Inter-
face

MicroEJ OS Application MicroEJ OS specific or forbidden

Array of base types Any Application Clone by copy

Arrays of references Any Application Clone and transfer rules applied again
on each element

Shared Interface Application Application Passing by indirect reference (Proxy cre-
ation)

Any Class, Array or Inter-
face

Application Application Forbidden

Objects created by an application which class is owned by MicroEJ OS can be transferred to an oth-
er application if this has been authorized by the firwmare. The list of eligible types that can be trans-
ferred is firwmare specific, so you have to consult the firmware specification. Table 7.2, “MicroEJ Eval-
uation Firmware Example of Transfer Types” lists firmware types allowed to be transferred through
a shared interface call. When an argument transfer is forbidden, the call is abruptly stopped and a
java.lang.IllegalAccessError is thrown by MicroEJ OS Core Engine.

Table 7.2. MicroEJ Evaluation Firmware Example of Transfer Types

Type Rule

java.lang.String Clone by copy

java.io.InputStream Proxy reference creation

java.util.Map<String,String> Clone by deep copy

7.2.3. Proxy Class Implementation

The Shared Interface mechanism is based on automatic proxy objects created by the underlying Mi-
croEJ OS Core Engine, so that each application can still be dynamically stopped and uninstalled. This
offers a reliable way for users and providers to handle the relationship in case of a broken link.

Once a shared interface has been declared as shared interface, a dedicated implementation is required
(called the Proxy class implementation). Its main goal is to perform the remote invocation and provide
a reliable implementation regarding the interface contract even if the remote application fails to fulfill
its contract (unexpected exceptions, application killed...). The MicroEJ OS Core Engine will allocate in-
stances of this class when an implementation owned by an other application is being transferred to
this application.
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Figure 7.3. Shared Interfaces Proxy Overview

A proxy class is implemented and executed on the client side, each method of the implemented inter-
face must be defined according to the following pattern:

package mypackage;

public class MyInterfaceProxy extends Proxy<MyInterface> implements

 MyInterface {

 @Override

 public void foo(){

  try {

   invoke(); // perform remote invocation

  } catch (Throwable e) {

   e.printStackTrace();

  }

 }

}

Each implemented method of the proxy class is responsible for performing the remote call and catch-
ing all errors from the server side and to provide an appropriate answer to the client application call
according to the interface method specification (contract). Remote invocation methods are defined in
the super class ej.kf.Proxy and are named invokeXXX() where XXX is the kind of return type.
As this class is part of the application, the application developer has the full control on the Proxy im-
plementation and is free to insert additional code such as logging calls and errors for example.

Table 7.3. Proxy Remote Invocation Built-in Methods

Invocation Method Usage

void invoke() Remote invocation for a proxy method that returns void

Object invokeRef() Remote invocation for a proxy method that returns a ref-
erence



Shared Interfaces

55

Invocation Method Usage

boolean invokeBoolean(), byte invoke-
Byte(), char invokeChar(), short in-
vokeShort(), int invokeInt(), long invoke-
Long(), double invokeDouble(), float in-
vokeFloat()

Remote invocation for a proxy method that returns a base
type

7.3. Shared Interface Example
The sample code hereafter shows an example of a Shared Interface named MyOutput with two methods
println and nbExec.

With this interface we will transform a simple "Hello" project into a print client using a shared interface
provided by a server application.

7.3.1. Write the Proxy Implementation

An example of a Proxy class for the MyOutput Shared Interface is shown hereafter:
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7.3.2. Prepare the Shared Interface Projects

To migrate the simple "Hello" application MySandboxedApp into a Shared Interface sample, first du-
plicate the MySandboxedApp project to a MySIUserApp project and add three files to this project:

• MyOutput.java to src/main/java folder in the sharedInterface package

• MyOutputProxy.java to src/main/java folder in the sharedInterface package

• sharedInterface.si to src/main/resources folder

The resulting modifications should appear as follows in MicroEJ Studio. Note the XML syntax of the .si
declaration file containing the full qualified name of the Shared Interface type.



Shared Interfaces

57

Once the MySIUserApp project is updated, duplicate it to a MySIProviderApp project, both
projects have the same content at this point.

Make sure to update the Application-Id fields of the MANIFEST.MF files of both projects so that
they are different from each other to prevent one application from overwriting the other when deploy-
ing on target.

Figure  7.4.  MANIFEST.MF file content for Shared Interface Provider application
project

Manifest-Version: 1.0

Application-Id: MySIProvider

Application-Version: 0.1.0

Application-PrintableName: MySIProvider

Application-Description: MySIProvider App

Application-BackgroundServices: appEntry.MyBackgroundCode

Figure 7.5. MANIFEST.MF file content for Shared Interface User application project

Manifest-Version: 1.0

Application-Id: MySIUser

Application-Version: 0.1.0

Application-PrintableName: MySIUser

Application-Description: MySIUser App

Application-BackgroundServices: appEntry.MyBackgroundCode

We will now specialize the Background Services.
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7.3.3. Implement the Provider Side

7.3.3.1. Create the Provider Implementation Class

The provider side implementation of a Shared Interface follows the standard rule of java language for
interface implementation. Add a new class with the name StandardOutput to the src/main/ja-
va folder, this class implements the sharedInterface.MyOutput interface.

7.3.3.2. Register the Provider as a Shared Interface Implementation

In order to expose or hide its implementation of the Shared Interface, the provider uses the MicroEJ
Registry service with the help of the ej.wadapps.registry.SharedRegistryFactory object.
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7.3.4. Implement the User Side

7.3.4.1. Write the User Behaviour

In order to generate periodic activity on the shared interface, the user application declares a Back-
ground Service that runs a cyclic thread.

7.3.4.2. Get the Provider Service Reference

After retrieving the ServiceLoader instance, the user gets a local reference to the registered
provider. (see Section 3.3, “Services Usage” for more informations on services references).
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7.3.4.3. Call the Provider Service

With a valid reference to the provider service, the user calls the MyOutput interface methods.

As the session is loosely coupled, the call is performed with an exception handler to prevent from a
change in the provider status. If the call fails, the user starts polling the service loader again to retrieve
a new valid instance.

To show the communication between MySIUserApp and MySIProviderApp, the two applications
must be locally deployed on a MicroEJ-ready device (see Section 2.3.4, “Deploy Locally on Hardware”).
The messages will be displayed on the standard output.
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7.4. System Registries
MicroEJ OS provides system registries that allow applications to publish/retrieve shared interfaces im-
plementations. When a shared interface instance is published into such kind of registry, the registry
makes it accessible to other applications. MicroEJ provides two system registries:

• The Wadapps framework shared registry (ej.wadapps.registry.SharedRegistry) is
dedicated to sharing service related interfaces.

Services can be retrieved using the following API
ej.components.dependencyinjection.ServiceLoader.getService(Class).
See Section 3.3, “Services Usage” for how to retrieve services.

• The ECOM device manager (ej.ecom.DeviceManager) registry is dedicated to sharing pe-
ripheral extensions related interfaces.

Applications can register device extensions that are dynamically discovered using the follow-
ing API ej.ecom.DeviceManager.register(Class<Device>, Device). See ECOM
foundation library API javadoc for more information.
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Chapter 8. MicroEJ Classpath
MicroEJ applications run on a target device and their footprint is optimized to fulfill embedded con-
straints. The final execution context is an embedded device that may not even have a file system. Files
required by the application at runtime are not directly copied to the target device, they are compiled
to produce the application binary code which will be executed by MicroEJ OS core engine.

As a part of the compile-time trimming process, all types not required by the embedded application
are eliminated from the final binary.

MicroEJ Classpath is a developer defined list of all places containing files to be embedded in the final
application binary. MicroEJ Classpath is made up of an ordered list of paths. A path is either a folder or
a zip file, called a JAR file (JAR stands for Java ARchive).

• Section 8.1, “Application Classpath” explains how the MicroEJ classpath is built from a MicroEJ
application project.

• Section 8.2, “Classpath Load Model” explains how the application content is loaded from Mi-
croEJ Classpath.

• Section 8.3, “Classpath Elements” specifies the different elements that can be declared in Mi-
croEJ Classpath to describe the application content.

• Section 8.4, “Foundation vs Add-On Libraries” explains the different kind of libraries that can be
added to MicroEJ Classpath.

• Finally, Section 8.5, “Library Dependency Manager” shows how to manage libraries dependen-
cies in MicroEJ.

8.1. Application Classpath
The following schema shows the classpath mapping from a MicroEJ application project to the MicroEJ
Classpath ordered list of folders and JAR files. The classpath resolution order (left to right) follows the
project appearance order (top to bottom).
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Figure 8.1. MicroEJ Application Classpath Mapping

8.2. Classpath Load Model
A MicroEJ Application classpath is created via the loading of :

• an entry point type

• all *.[extension].list files declared in a MicroEJ Classpath.

The different elements that constitute an application are described in Section  8.3, “Classpath Ele-
ments”. They are searched within MicroEJ Classpath from left to right (the first file found is loaded).
Types referenced by previously loaded MicroEJ Classpath elements are loaded transitively.
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Figure 8.2. Classpath Load Principle

8.3. Classpath Elements
The MicroEJ Classpath contains the following elements:

• An entrypoint described in section Section 8.3.1, “Application Entry Points”

• Types in .class files, described in section Section 8.3.2, “Types”

• Raw resources, described in section Section 8.3.3, “Raw Resources”

• Immutables Object data files, described in Section Section 8.3.4, “Immutable Objects”

• Images and Fonts resources

• *.[extension].list files, declaring contents to load. Supported list file extensions and
format is specific to declared application content and is described in the appropriate section.

8.3.1. Application Entry Points
MicroEJ application entry point is a class that contains a public static void main(String[])
method. In case of MicroEJ Sandboxed Application, this entry point is automatically generated by Mi-
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croEJ Studio from declared Activity and/or BackgroundService types. In case of a MicroEJ Standalone
application, this has to be defined by the user.

8.3.2. Types

MicroEJ types (classes, interfaces) are compiled from source code (.java) to classfiles (.class).
When a type is loaded, all types dependencies found in the classfile are loaded (transitively).

A type can be declared as a Required type in order to enable the following usages:

• to be dynamically loaded from its name (with a call to Class.forName(String))

• to retrieve its fully qualified name (with a call to Class.getName())

A type that is not declared as a Required type may not have its fully qualified name (FQN) embedded.
Its FQN can be retrieved using the stack trace reader tool (see Section 9.2, “Strack Trace Reader”).

Required Types are declared in MicroEJ Classpath using *.types.list files. The file format is a stan-
dard Java properties file, each line listing the fully qualified name of a type. Example:

Example 8.1. Required Types *.types.list File Example

# The following types are marked as MicroEJ Required Types

com.mycompany.MyImplementation

java.util.Vector

8.3.3. Raw Resources

Raw resources are binary files that need to be embedded by the application so that they may be dynam-
ically retrieved with a call to Class.getResourceAsStream(java.io.InputStream). Raw
Resources are declared in MicroEJ Classpath using *.resources.list files. The file format is a stan-
dard Java properties file, each line is a relative / separated name of a file in MicroEJ Classpath to be
embedded as a resource. Example:

Example 8.2. Raw Resources *.resources.list File Example

# The following resource is embedded as a raw resource

com/mycompany/MyResource.txt

8.3.4. Immutable Objects

Immutables objects are regular read-only objects that can be retrieved with a call to
ej.bon.Immutables.get(String). Immutables objects are declared in files called immutable
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objects data files, which format is described in the [B-ON] specification (http://e-s-r.net). Im-
mutables objects data files are declared in MicroEJ Classpath using *.immutables.list files. The
file format is a standard Java properties file, each line is a / separated name of a relative file in MicroEJ
Classpath to be loaded as an Immutable objects data file. Example:

Example 8.3. Immutable Objects Data Files *.immutables.list File Example

# The following file is loaded as an Immutable objects data files

com/mycompany/MyImmutables.data

8.3.5. System Properties

System Properties are key/value string pairs that can be accessed with a call to
System.getProperty(String). System properties are declared in MicroEJ Classpath
*.properties.list files. The file format is a standard Java properties file. Example:

Example 8.4. System Properties *.properties.list File Example

# The following property is embedded as a System property

com.mycompany.key=com.mycompany.value

8.3.6. Images

8.3.6.1. Overview

Images are graphical resources that can be accessed with a call to
ej.microui.display.Image.createImage(). To be displayed, these images have to be con-
verted from their source format to the display raw format. The conversion can either be done at :

• build-time (using the image generator tool)

• run-time (using the relevant decoder library)

Images that must be processed by the image generator tool are declared in MicroEJ Classpath
*.images.list files. The file format is a standard Java properties file, each line representing a /
separated resource path relative to the MicroEJ classpath root referring to a standard image file (e.g.
.png, .jpg). The resource may be followed by an optional parameter (separated by a :) which defines
and/or describe the image output file format (raw format). When no option is specified, the image is
embedded as-is and will be decoded at run-time (although listing files without format specifier has no
impact on the image generator processing, it is advised to specify them in the *.images.list files
anyway, as it makes the run-time processing behavior explicit). Example:
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Figure 8.3. Image Generator *.images.list File Example

# The following image is embedded 
# as a PNG resource (decoded at run-time)
com/mycompany/MyImage1.png

# The following image is embedded 
# as a 16 bits format without transparency (decoded at build-time)
com/mycompany/MyImage2.png:RGB565

# The following image is embedded 
# as a 16 bits format with transparency (decoded at build-time)
com/mycompany/MyImage3.png:ARGB1555

8.3.6.2. Output Formats

8.3.6.2.1. No Compression

When no output format is set in the images list file, the image is embedded without any conversion /
compression. This allows you to embed the resource as well, in order to keep the source image char-
acteristics (compression, bpp etc.). This option produces the same result as specifiying an image as a
resource in the MicroEJ launcher.

Advantages:

• Preserves the image characteristics.

Disadvantages:

• Requires an image runtime decoder.

• Requires some RAM in which to store the decoded image

Figure 8.4. Unchanged Image Example

image1

8.3.6.2.2. Display Output Format

This format encodes the image into the exact display memory representation. If the image to en-
code contains some transparent pixels, the output file will embed the transparency according to the
display's implementation capacity. When all pixels are fully opaque, no extra information will be stored
in the output file in order to free up some memory space.

Advantages:

• Drawing an image is very fast.

• Supports alpha encoding.
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Disadvantages:

• No compression: the image size in bytes is proportional to the number of pixels.

Figure 8.5. Display Output Format Example

image1:display

8.3.6.2.3. Generic Output Formats

Depending on the target hardware, several generic output formats are available. Some formats may
be directly managed by the BSP display driver. Refer to the platform specification to retrieve the list
of natively supported formats.

Advantages:

• The pixels layout and bits format are standard, so it is easy to manipulate these images on the
C-side.

• Drawing an image is very fast when the display driver recognizes the format (with or without
transparency).

• Supports or not the alpha encoding: select the most suitable format for the image to encode.

Disadvantages:

• No compression: the image size in bytes is proportional to the number of pixels, the transparen-
cy, and the bits-per-pixel.

Select one the following format to use a generic format:

• ARGB8888: 32 bits format, 8 bits for transparency, 8 per color.

• RGB888: 24 bits format, 8 per color. Image is always fully opaque.

• ARGB4444: 16 bits format, 4 bits for transparency, 4 per color.

• ARGB1555: 16 bits format, 1 bit for transparency, 5 per color.

• RGB565: 16 bits format, 5 or 6 per color. Image is always fully opaque.

• A8: 8 bits format, only transparency is encoded. The color to apply when drawing the image, is
the current GraphicsContext color.

• A4: 4 bits format, only transparency is encoded. The color to apply when drawing the image, is
the current GraphicsContext color.

• A2: 2 bits format, only transparency is encoded. The color to apply when drawing the image, is
the current GraphicsContext color.

• A1: 1 bit format, only transparency is encoded. The color to apply when drawing the image, is
the current GraphicsContext color.

Figure 8.6. Generic Output Format Examples

image1:ARGB8888
image2:RGB565
image3:A4
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8.3.6.2.4. RLE1 Output Format

The image engine can display embedded images that are encoded into a compressed format which
encodes several consecutive pixels into one or more 16-bits words. This encoding manages a maximum
alpha level of 2 (alpha level is always assumed to be 2, even if the image is not transparent).

• Several consecutive pixels have the same color (2 words).

• First 16-bit word specifies how many consecutive pixels have the same color.

• Second 16-bit word is the pixels' color.

• Several consecutive pixels have their own color  (1 + n words).

• First 16-bit word specifies how many consecutive pixels have their own color.

• Next 16-bit word is the next pixel color.

• Several consecutive pixels are transparent (1 word).

• 16-bit word specifies how many consecutive pixels are transparent.

Advantages:

• Supports 0 & 2 alpha encoding.

• Good compression when several consecutive pixels respect one of the three previous rules.

Disadvantages:

• Drawing an image is slightly slower than when using Display format.

Figure 8.7. RLE1 Output Format Example

image1:RLE1

8.3.7. Fonts

8.3.7.1. Overview

Fonts are graphical resources that can be accessed with a call to
ej.microui.display.Font.getFont(). To be displayed, these fonts have to be converted at
build-time from their source format to the display raw format by the font generator tool. Fonts that
must be processed by the font generator tool are declared in MicroEJ Classpath *.fonts.list files.
The file format is a standard Java properties file, each line representing a / separated resource path
relative to the MicroEJ classpath root referring to a MicroEJ font file (usually with a .ejf file extension).
The resource may be followed by optional parameters which define :

• some ranges of characters to embed in the final raw file

• the required pixel depth for transparency.
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By default, all characters available in the input font file are embedded, and the pixel depth is 1 (i.e 1
bit-per-pixel). Example:

Figure 8.8. Font Generator *.fonts.list File Example

# The following font is embedded with all characters
# without transparency
com/mycompany/MyFont1.ejf

# The following font is embedded with only the latin 
# unicode range without transparency 
com/mycompany/MyFont2.ejf:latin

# The following font is embedded with all characters
# with 2 levels of transparency
com/mycompany/MyFont2.ejf::2

MicroEJ font files conventionally end with the .ejf suffix and are created using the Font Designer (see
Section 9.1, “Font Designer”).

8.3.7.2. Font Range

The first parameter is for specifying the font ranges to embed. Selecting only a specific set of characters
to embed reduces the memory footprint. Several ranges can be specified, separated by ;. There are
two ways to specify a character range: the custom range and the known range.

8.3.7.2.1. Custom Range

Allows the selection of raw Unicode character ranges.

Examples:

• myfont:0x21-0x49: Embed all characters from 0x21 to 0x49 (included).

• myfont:0x21-0x49,0x55: Embed all characters from 0x21 to 0x49 and character 0x55

• myfont:0x21-0x49;0x55: Same as previous, but done by declaring two ranges.

8.3.7.2.2. Known Range

A known range is a range defined by the "Unicode Character Database" available on http://
www.unicode.org/. Each range is composed of sub ranges that have a unique id.

Examples:

• myfont:latin: Embed all latin characters.

• myfont:latin(5): Embed all latin characters of sub range 5 (0xD8 to 0xF6).

• myfont:latin(1-5): Embed all latin characters of sub ranges 1 to 5.

• myfont:latin(1-5,7): Embed all latin characters of sub ranges 1 to 5 and 7.
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• myfont:latin(1-5);latin(7): Same as previous, but done by declaring two ranges.

• myfont:latin(1-5);han:  Embed all latin characters of sub ranges 1 to 5, and all han char-
acters.

8.3.7.3. Transparency

The second parameter is for specifying the font transparency level (1, 2, 4 or 8).

Examples:

• myfont:latin:4: Embed all latin characters with 4 levels of transparency

• myfont::2: Embed all characters with 2 levels of transparency

8.4. Foundation vs Add-On Libraries
A MicroEJ Foundation Library is a MicroEJ Core library that provides core runtime APIs or hardware-de-
pendent functionality. A Foundation library is divided into an API and an implementation. A Foundation
library API is composed of a name and a 2 digits version (e.g. EDC-1.2, MWT-2.0) and follows the se-
mantic versioning (http://semver.org) specification. A Foundation library API only contains pro-
totypes without code. Foundation library implementations are provided by MicroEJ Platforms. From a
MicroEJ Classpath, Foundation library APIs dependencies are automatically mapped to the associated
implementations provided by the platform on which the application is being executed.

A MicroEJ Add-On Library is a MicroEJ library that is implemented on top of MicroEJ Foundation Li-
braries (100% full Java code). A MicroEJ Add-on Library is distributed in a single JAR file, with most
likely a 3 digits version and provides its associated source code.

Foundation and add-on libraries are added to MicroEJ Classpath by the application developer using
Ivy (see Section 8.5, “Library Dependency Manager”).

Figure 8.9. MicroEJ OS Foundation and Add-On Libraries

8.5. Library Dependency Manager
MicroEJ uses Ivy (http://ant.apache.org/ivy) as its dependency manager for building MicroEJ
classpath.
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An Ivy configuration file must be provided in each MicroEJ project to solve classpath dependencies.
Multiple Ivy configuration file templates are available depending on the kind of MicroEJ application
created.

Example 8.5. Ivy File Template for a Sandboxed Application

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org"

 xmlns:m="http://ant.apache.org/ivy/extra"> 

    <info organisation="com.mycompany" module="myapp"

 status="integration" revision="0.1.0">

        <ea:build organisation="com.is2t.easyant.buildtypes"

 module="build-application" revision="5.+">

        </ea:build>

    </info>

    

    <configurations defaultconfmapping="default->default;provided-

>provided">

  <conf name="default" visibility="public"/>

  <conf name="provided" visibility="public"/>

  <conf name="documentation" visibility="public"/>

  <conf name="source" visibility="public"/>

  <conf name="dist" visibility="public"/>

   <conf name="test" visibility="private"/>

   <conf name="microej.launch.standalone""/>

    </configurations>

    

    <publications>

    </publications>

    

    <dependencies>

   <!-- Declare a Foundation Library API dependency -->

        <dependency org="ej.api" name="edc" rev="[1.2.0-RC0,2.0.0-

RC0[" conf="provided->*" />

   <!-- Declare an Add-On Library dependency -->

        <dependency org="ej.library.wadapps" name="framework"

 rev="[1.2.0-RC0,2.0.0-RC0[" />      

    </dependencies>

</ivy-module>

Dependencies are declared within the <dependencies> tag

• Foundation libraries are declared using the "provided->*" configuration. Without this, they
will be considered as a regular Add-On libraries and will not be mapped to the associated im-
plementation provided by the platform.

• Add-On libraries are declared with the default runtime configuration. All their declared depen-
dencies will be fetched transitively.
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8.6. Central Repository
The MicroEJ Central Repository is the Ivy repository maintained by MicroEJ. It contains Foundation li-
brary APIs and numerous Add-On Libraries. Foundation libraries APIs are distributed under the organi-
zation ej.api. All other artifacts are Add-On libraries.

For more information, please visit https://developer.microej.com.
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Chapter 9. Additional Tools

9.1. Font Designer
MicroEJ Font Designer allows to create embedded fonts files (see Section 8.3.7, “Fonts”) from standard
font files formats. The Font Designer documentation is available at: Help > Help Contents >
Font Designer User Guide.

9.2. Strack Trace Reader
When an application is deployed on a device, stack traces dumped on standard output are not directly
readable: non required types (see Section 8.3.2, “Types”) names, methods names and methods line
numbers may not have been embedded to save code space. A stack trace dumped on the standard
output can be decoded using the Stack Trace Reader tool.

Starting from the Background Service application example (see Chapter 5, Background Service Appli-
cation), write a new line to dump the currently executed stack trace on the standard output.

Figure 9.1. Code to Dump a Stack Trace

To be able to decode an application stack trace, the stack trace reader tool requires the application
binary file with debug information. To get this file being generated on the next deployment, edit the
launch configuration Run > Run Configuration... > MySandboxedApp [LOCAL].In the
Execution tab, uncheck the Clean intermediate files option.
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Figure 9.2. Local Deployment Configuration with Intermediate Files

Click on Run button. The application is built and deployed. The output folder now contains the appli-
cation binary file with debug information (feature/application.fo.o). Note that the file which
is uploaded on the device is application.fo (stripped version without debug information).

Figure 9.3. Application Binary File with Debug Information

On successful deployment, the application is started on the device and the following trace is dumped
on standard output.
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Figure 9.4. Stack Trace Output

To create a new MicroEJ Tool configuration, right-click on the application project and click on Run
As... > Run Configurations....

In Execution tab, select the Stack Trace Reader tool.

Figure 9.5. Select Stack Trace Reader Tool

In Configuration tab, browse the previously generated application binary file with debug informa-
tion (application.fo.o)
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Figure 9.6. Stack Trace Reader Tool Configuration

Click on Run button and copy/paste the trace into the Eclipse console. The decoded trace is dumped
and the line corresponding to the application hook is now readable.

Figure 9.7. Read the Stack Trace

The stack trace reader can simultaneously decode heterogeneous stack traces with lines owned by dif-
ferent applications and the firmware. Other debug information files can be appended using the Ad-
ditional object files option. Lines owned by the firmware can be decoded with the firwmare
debug information file (optionally made available by your firmware provider).
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